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File 
The File menu is where all file related operations are 

accessed.    The options are:
(Hit Page PgDn for more information)

Note:    When Kid Mode is turned on some of the options below are substituted for another, See 
Kid Mode On/Off  for more details

New
This option returns the user to a blank screen with no file association.    It is in effect a complete 

startover option.

Open...
This menu option starts a dialog box for the user to choose a bitmap file (*.bmp) file to open.    

ColorBook also will open most Run Length Encoded bitmap files(*.rle).

Open Coloring Book...
This is ColorBook's coloring book option.    Choose this option to bring up a dialog box with 

drawings to color.    To open a picture, select a picture with the left mouse button and then press the OK 
button.    A shortcut is to double-click the picture you wish to open.

Save
This option saves a picture in bitmap format (*.bmp) in a file whose name is listed in the window 

title.    Please observe that only filenames with filenames of the form cbx.bmp, where x is a number, will 
be noticed by ColorBook's coloring book feature.    See the option File|Add Picture to Book  for more 
details.

Turn off File Compression to save in a format recognized by Paintbrush!!

SaveAs
This option save a picture in bitmap format (*.bmp) in a file with the name you type into the dialog 

box.    Note that only when Kid Mode is off the dialog box to type a file name into will appear, when Kid 
Mode is on both File|Save and File|SaveAs are identical to the File|Add Picture to Book described below.  
See option File|Save above for more details.    

Turn off File Compression to save in a format recognized by Paintbrush!!

Add Picture to Book
This option adds the current picture to the coloring book.    This picture may then be used over 

and over again.    There is a limit of 40 pictures that may be saved in this fashion, after that the user must 
delete an existing picture in order to save a new picture.

Print
This is the option to print the current picture.    ColorBook does print in color when attached to a 

color printer.    The picture is changed to monochrome shading when attached to a monochrome printer.

Turn off Kid Mode to Print!!



Quit  
Choose this option to exit ColorBook.    Remember to save your work!!!



Edit 
The Edit menu is where all editing related operations are 

accessed.    The options are:
(Hit Page PgDn for more information)

Cut
This option is identical to the File|New option except that it puts the existing picture in the 

Windows Clipboard.

Copy
This option puts the current ColorBook canvas into the Windows Clipboard.    Use this option to 

move your ColorBook pictures to other programs.

Paste
This option takes the contents of the Windows Clipboard and puts it on the ColorBook canvas.    

ColorBook expands/shrinks the clipboard image as needed to fill the entire ColorBook canvas.

Clear Screen
This option clears the ColorBook canvas.    File name associations are unaffected.

Uncolor Picture
This option uncolors the current picture.    This option may be used before adding a picture to the 

coloring book because it reduces the file size needed to store the picture.    

NOTE: This procedure may take a few minutes,    this is the price ColorBook pays to accurately uncolor a 
picture.



Options 

The Options menu is where all advanced operations are 
accessed.    The options are:
(Hit Page PgDn for more information)

Sound Effects
This option toggles the sound effects on and off.

Kid Mode
This option is intended to allow un-supervised use of ColorBook by new Windows users.    This 

option is the default option and is turned on when ColorBook is started.

Kid Mode keeps the ColorBook canvas maximized in order to discourage the user from switching 
to another application and inadvertently destroying important files or data.    This option may be disabled 
by choosing this option from the menu or by using the shortcut key sequence ALT-k.

See Kid Mode On/Off for more details.

Text in Current Color
This option allows the text placed by the text option to be in the current color.

Change Text Font
This option allows the text font to be changed from a Windows standard font dialog box.    All 

Fonts installed into Windows will be available.

Lines in Current Color
This option allows lines to be drawn in the current color as indicated by the current color box in 

the upper left hand corner of the canvas.    The current color Box is the region of Blue in the picture below.

Choose Line Width and Color...
This option brings up a dialog box from which the line width and color may be changed.

Draw Color-Filled Objects
This option allows drawing objects to be drawn with their interiors filled with the current color.

Allow Coloring with Black
This option allows coloring with the color BLACK.    In normal operation ColorBook does not allow 

this color to be used because the borders of the coloring pictures are in black.    If the user changes the 



border color then the coloring feature will not work correctly.

Warning!!!: this option when activated may result in unexpected behavior.    Be sure to save your work 
before activating this feature!!!!!!!!

Make Your Own Color...
ColorBook comes with 54 pre-defined colors.    However, the user may want to mix their own 

custom color and replace a pre-defined color.    By using this option the user can re-define all 54 colors if 
desired.

The custom colors are not saved when the user quits ColorBook.

Restore Colors to Default
This option restores all 54 top menu colors to the pre-defined default.    See the Choose Custom 

Colors... option for more information.
 
File Compression

This option turns file compression on and off.    Picture files are compressed when the check mark
appears by the menu item.    This is included because Window's Paintbrush can not read a compressed 
file.    Therefore, to save a file in Paintbrush format turn file compression off.



Help 
The Help menu is where instructive information is contained.    The 

options are:

Contents
This option is the option your are now using.    It may be invoked at any time by pressing the    F1  function
key.

Help on Help
This option invokes Window's instructions on how to use the HELP utility.

Print Registration Form
This version of ColorBook for Windows is shareware and needs to be registered with MES for continued 
use.    Choose this option to print out an order form to register ColorBook for Windows.    With registration 
you will receive a free copy of LaserBlast for Windows, a program to teach counting.    With registration 
you will also receive a discount on other educational software purchased in the future from MES.    
Register today!!!

About ColorBook
This option brings up a dialog box with version and registration information.



Add to Coloring Book
ColorBook comes with one 40 page coloring book of predrawn images.    These images are in 

such a form as to be unchangeable by the user.    That is why ColorBook allows for an additional 40 
images to be added in a second book by the user.

This is accomplished by choosing Add Picture To Book item from the File menu.    ColorBook will 
take the current drawing on the screen, create a miniature image from the current drawing and save both 
the normal size and miniature images to your disk drive.    At one point during this process you will need to
press the OK button on a preview of the miniature image.

There is no option to abort this procedure at this time.    However if you change your mind you 
may delete the coloring book entry from the Coloring book dialog window.

For Best results you may wish to un-color the picture before you add the picture to the coloring 
book.



Change Menu Colors
The top menu colors may be changed one by one if the user wishes to have a shade not included

in the original palette.    This is accomplished by choosing the Options|Make Your Own Color item from the
options menu.    Then place the mouse cursor over the color to change.    Pressing the right mouse button 
menu brings up a color dialog box in which a custom color may be mixed.    Pressing the OK button in this
dialog box replaces the color with the new color.      To turn off this option choose Options|Make Your Own 
Color so that this menu item appears unchecked.

Note that these custom colors exist only for the current session, when ColorBook is restarted all 
previous custom colors are lost.



Change Picture Colors
Changing the coloring of a picture is the purpose of ColorBook.    In this respect ColorBook has a 

great advantage over traditional coloring books.    To change a color from the existing color to another 
color merely select the new color from the top menu with the left mouse button.    Then choose the crayon 
tool from the side menu, this tool is the top tool in this menu.    Then merely place the tip of the floating 
crayon on the color to change and press the left mouse button.



Delete a Picture
Only user-drawn pictures may be deleted!    To delete a user-drawn picture select the Open 

Coloring Book dialog either by the open book icon in the side menu or from the file main menu.    Select a 
user-drawn picture by clicking on the miniature icon and then select the Delete button in the bottom of the 
dialog box.    The user will be prompted to confirm deletion of the file.    Choose OK to delete the picture or
Cancel to not delete the picture.    The dialog box will then redisplay itself to reflect the deleted item.



Export through the Clipboard
To include images from ColorBook in your other Windows programs you may use the Windows 

Clipboard.    This allows you to take the entire drawing area (excluding the top and side menus) and paste
it into other programs such as your favorite word processor, etc.    ColorBook exports both device 
dependent and device independent bitmaps when this option is chosen.

To export a picture that is currently in the ColorBook canvas chose Edit|Copy from the Edit main 
menu.    Then switch to the program where you want to place the picture and choose Paste from that 
program's Edit Menu.



Import from the Clipboard
To include images from your other Windows programs in ColorBook you may use the Windows 

Clipboard.    This allows you to take images from other paint programs or any other Windows or DOS 
program that displays an image and import it into ColorBook for alteration and/or saving.    ColorBook will 
import both device dependent and device independent bitmaps, however if both formats are available in 
the clipboard ColorBook will chose the device dependent format.    Colorbook will use the device 
independent format only if no device dependent format is available.

To transfer an image from a DOS program to ColorBook you must display the DOS program in a 
Window.    Then choose Edit|Mark from the Corner    Window Menu and use the mouse to select the 
image.    Then choose Edit|Copy from the DOS programs corner menu.    After this is done switch to 
ColorBook and Choose Edit|Paste.    This will take the contents of the Clipboard and stretch/shrink it so 
that it fits ColorBook's canvas exactly.    By turning Kid Mode on or off the user can achieve a resizing of 
an image by experimenting with the Colorbook Window size that produces the desired result.      



Kid Mode On/Off
Kid mode is a feature that keeps the ColorBook window full-sized to discourage small children 

from tampering with important programs and/or data.    To toggle this feature On or Off choose Options|Kid
Mode from the options menu or use the accelerator key sequence ALT-k.    A message dialog box will 
inform you whether Kid Mode is either on or off, hit the return key or click the OK button with the mouse to
dismiss the message dialog.

In addition to the above features Kid Mode also alters some entries in the File main menu to 
simplify the use of ColorBook for new users.    Below is a description of the file menu when Kid Mode is 
on:

Print is disabled, turn Kid Mode off to print.
Open Coloring Book is substituted for New and Open.
Add Picture to Book is substituted for Save and SaveAs.

Turning Kid Mode off will return the menu to full operation.



Open Coloring Book
To open the coloring book click the book icon at the bottom of the side menu or choose File|Open

Coloring Book from the main menu.    Either operation brings up a dialog box containing miniature images 
of the coloring pages.    To color one of these images select it with the mouse and then select the OK 
button at the bottom of the dialog.    You may also double-click the picture you wish to color and it will be 
opened.

To access the user drawn coloring book select the Next Book button of the dialog box.    To return 
to the original coloring book just select the next book button again.    In this manner the user can swap 
from one book to the other.

This version of Colorbook comes with only one coloring book included with the application.    
However, it has been programmed to accept and manage up to 10 coloring books with no additional 
updates except for the purchase of additional coloring books.    Contact MES for availability.



Place Text on Picture
To place text on the picture select the 'A' icon near the bottom in the side menu with the mouse.    

A dialog box will come up with a place to type the text into.    The backspace key will allow for the user to 
correct mistakes, if needed.    Then choose the OK button to dismiss the dialog box.    The cursor will 
change to an 'A' when the cursor is over the drawing area.    Press and hold the left mouse button and a 
floating rectangle will appear in the size required to hold the text to allow the user to place the text exactly 
where it is wanted.    Releasing the mouse button actually places the text where the rectangle was 
positioned.

To change the text font choose Options|Change Text Font...    from the options menu.



Print Current Picture
ColorBook has the ability to print out what the user colors.    If a color printer is available 

ColorBook will print in color.    ColorBook will operate with most any printer that can be installed in 
Windows.    In the case of a monochrome printer ColorBook will translate colors other than black to a gray 
shading pattern when printed.

Another interesting use of ColorBook is that the user may print out the un-colored images so that 
each sibling or friend may color the same drawing with real crayons.

Note:    Kid Mode must be turned off in order to print!



Sound Effects On/Off
ColorBook provides simple sound effects to entertain the user and/or spectators.    If wanted 

these sound effects may be turned off by selecting the speaker icon second to bottom from the side menu
or by choosing the Options|Sound Effects from the main menu.    When sound effects are on the speaker 
icon will be inverted so that the status of the sound effects may be seen at one glance.

The sound effects in ColorBook consist of:

1) A short tune associated with each side menu icon.    The tune will sound when the side men item is 
chosen for the first time and every time that operation is completed.

2) When mouse is moving in the top color menu each color is treated like one of the piano 
keys.    This gives the same effect as running the finger over the piano keyboard.



Coloring Books 
ColorBook comes with one 40 page coloring book of pre-drawn images for your coloring 

pleasure.    In addition ColorBook provides for a user drawn 40 page coloring book as well.

The ColorBook drawings were drawn by hand by Evelyn White and later scanned into electronic 
format.    Ms. White is a public school Art instructor in Tazewell TN who also has a thriving artistic career.   
She works in calligraphy, oil painting and freelance art from her studio.    If you would like to see more of 
Ms. White's artistic work write to:

Evelyn White
1508 Tazewell Rd.
Tazewelll, TN 37879
ph (615) 626-9106



Other Educational Products From MES 
ColorBook is the first of a series of educational software from Motes Educational Software (MES) 

for Microsoft Windows.    The next product to be released is a collection of programs to teach numbers 
and arithmetic.    It will be known as SchoolMom for Windows Volume II (ADD).    

MES also has a successful line of educational software for DOS that has won various awards 
from the educational software community.      If you would like to receive more information about MES 
products, please contact MES through one of the means listed below.

If you would like to order software and pay by credit card please call the toll free number below 
and have your VISA or MasterCard ready.    Of course MES also accepts payment through more 
traditional means such as personal check issued from a US Bank or Postal or International money order.

Telephone (for orders only, please): 1-800-839-7031

This line is for orders only please, the operator may not be familiar with
the products.    If you have questions please call

                    (501)-524-8741.          
Otherwise write to:

U.S. Mail: Motes Educational Software
P. O. Box 575
Siloam Springs AR, 72761

Electronic Mail: 73757,1111              on CompuServe

or from Internet 73757.1111@compuserve.com 




